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Preface

Purpose

Audience

The S7-200 series is a line of micro-programmable logic controllers (Micro PLCs) that can
control a variety of automation applications. Compact design, low cost, and a powerful
instruction set make the S7-200 controllers a perfect solution for controlling small
applications. The wide variety of CPU sizes and voltages, and the multiple programming
options available, give you the flexibility you need to solve your automation problems.

This manual provides information about installing and programming the S7-200 Micro PLCs,
including the following topics:

* |Installing and wiring the S7-200 CPU and expansion /O modules, and installing the
STEP 7-Micro/WIN software

* Designing and entering a program

* Understanding the CPU operations, such as data types and addressing modes, the CPU
scan cycle, password-protection, and network communication

This manual also includes descriptions and examples for the programming instructions,
typical execution times for the instructions, and the data sheets for the S7-200 equipment.

This manual is designed for engineers, programmers, installers, and electricians who have a
general knowledge of programmable logic controllers.

Scope of the Manual

The information contained in this manual pertains in particular to the following products:

e S7-200 CPU models: CPU 212 Release 1.01, CPU 214 Release 1.01,
CPU 215 Release 1.02, and CPU 216 Release 1.02

* \ersion 2.1 of STEP 7-Micro/WIN programming software packages:
— STEP 7-Micro/WIN 16 for the 16-bit Windows 3.1x
— STEP 7-Micro/WIN 32 for the 32-bit Windows 95 and Windows NT

Agency Approvals

The SIMATIC S7-200 series meets the standards and regulations of the following agencies:
* European Community (CE) Low Voltage Directive 73/23/EEC

® European Community (CE) EMC Directive 89/336/EEC

* Underwriters Laboratories, Inc.: UL 508 Listed (Industrial Control Equipment)

® Canadian Standards Association: CSA C22.2 Number 142 Certified (Process Control
Equipment)

* Factory Mutual Research: FM Class |, Division 2, Groups A, B, C, & D Hazardous
Locations, T4A

* VDE 0160: Electronic equipment for use in electrical power installations

Refer to Appendix A for compliance information.

S7-200 Programmable Controller System Manual
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Related Information
Refer to the following documentation for more detailed information about selected topics:

e ET 200 Distributed I/0O System Manual: describes how to install and use the ET 200
products for distributed I/O.

* Process Field Bus (PROFIBUS) standard (EN 50170): describes the standard protocol
for the S7-200 DP communication capability.

® TD 200 Operator Interface User Manual: describes how to install and use the TD 200
with an S7-200 programmable logic controller.

How to Use This Manual

If you are a first-time (novice) user of S7-200 Micro PLCs, you should read the entire manual.
If you are an experienced user, refer to the table of contents or index to find specific
information.

The manual is organized according to the following topics:

* ‘“Introducing the S7-200 Micro PLC” (Chapter 1) provides an overview of some of the
features of the equipment.

* ‘“Installing an S7-200 Micro PLC” (Chapter 2) provides procedures, dimensions, and
basic guidelines for installing the S7-200 CPU modules and expansion I/O modules.

® ‘“Installing and Using the STEP 7-Micro/WIN Software” (Chapter 3) describes how to
install the programming software. It also provides a basic explanation about the features
of the software.

® “Getting Started with a Sample Program” (Chapter 4) helps you enter a sample program,
using the STEP 7-Micro/WIN software.

e “Additional Features of STEP 7-Micro/WIN” (Chapter 5) describes how to use the TD 200
Wizard and the S7-200 Instruction Wizard, and other new features of STEP 7-Micro/WIN.

* “Basic Concepts for Programming an S7-200 CPU” (Chapter 6), “CPU Memory: Data
Types and Addressing Modes” (Chapter 7), and “Input/Output Control” (Chapter 8)
provide information about how the S7-200 CPU processes data and executes your
program.

* “Network Communications and the S7-200 CPU” (Chapter 9) provides information about
how to connect the S7-200 CPU to different types of networks.

* ‘“Instruction Set” (Chapter 10) provides explanations and examples of the programming
instructions used by the S7-200 CPUs.

Additional information (such as the equipment data sheets, error code descriptions,
execution times, and troubleshooting) are provided in the appendices.

Additional Assistance

For assistance in answering technical questions, for training on this product, or for ordering,
contact your Siemens distributor or sales office.

For Internet information about Siemens products and services, technical support, or FAQs
(frequently asked questions) and application tips, use this Internet address:

http://www.ad.siemens.de

. S7-200 Programmable Controller System Manual
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Introducing the S7-200 Micro PLC

The S7-200 series is a line of micro-programmable logic controllers (Micro PLCs) that can
control a variety of automation applications. Figure 1-1 shows an S7-200 Micro PLC. The
compact design, expandability, low cost, and powerful instruction set of the S7-200 Micro
PLC make a perfect solution for controlling small applications. In addition, the wide variety of
CPU sizes and voltages provides you with the flexibility you need to solve your automation

problems.
SIMATIC
S$7-200
EARRD.
Figure 1-1 S7-200 Micro PLC
Chapter Overview
Section Description Page
11 Comparing the Features of the S7-200 Micro PLCs 1-Z
1.2 Major Components of the S7-200 Micro PLC 1-4
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Introducing the S7-200 Micro PLC

1.1 Comparing the Features of the S7-200 Micro PLCs

Equipment Requirements

Figure 1-2 shows the basic S7-200 Micro PLC system, which includes an S7-200 CPU
module, a personal computer, STEP 7-Micro/WIN programming software, and a
communications cable.

In order to use a personal computer (PC), you must have one of the following sets of
equipment:

* APC/PPI cable
* A communications processor (CP) card and multipoint interface (MPI) cable

* A multipoint interface (MPI) card. A communications cable is provided with the MPI card.

Computer
S7-200 CPU
= [ sicmens |
|
0
STEP 7-Micro/WIN
PC/PPI Cable

Figure 1-2 Components of an S7-200 Micro PLC System

Capabilities of the S7-200 CPUs

The S7-200 family includes a wide variety of CPUs. This variety provides a range of features
to aid in designing a cost-effective automation solution. Table 1-1 provides a summary of the
major features of each S7-200 CPU.

S7-200 Programmable Controller System Manual
1-2 C79000-G7076-C230-02



Introducing the S7-200 Micro PLC

Table 1-1

Summary of the S7-200 CPUs

Feature

CPU 212

CPU 214

CPU 215

CPU 216

Physical Size of Unit

160 mm x 80 mm|
X 62 mm

197 mm x 80 mm
X 62 mm

218 mm x 80 mm
X 62 mm

218 mm x 80 mm
X 62 mm

Memory

Program (EEPROM) 512 words 2 Kwords 4 Kwords 4 Kwords

User data 512 words 2 Kwords 2.5 Kwords 2.5 Kwords
Internal memory bits 128 256 256 256

Memory cartridge None Yes (EEPROM) |Yes (EEPROM) |Yes (EEPROM)
Optional battery cartridge | None 200 days typical | 200 days typical | 200 days typical

Backup (super capacitor)

50 hours typical

190 hours typical

190 hours typical

190 hours typical

Inputs/Outputs (I/0)

Local /10 8 DI/ 6 DQ 14 DI/ 10 DQ 14 DI/ 10 DQ 24 DI/ 16 DQ
Expansion modules (max.) | 2 modules 7 modules 7 modules 7 modules
Process-image 1/O register| 64 DI / 64 DQ 64 DI/ 64 DQ 64 DI/ 64 DQ 64 DI / 64 DQ
Analog I/O (expansion) 16 Al /16 AQ 16 Al /16 AQ 16 Al /16 AQ 16 Al /16 AQ
Selectable input filters No Yes Yes Yes

Instructions

Boolean execution speed

1.2 ys/instruction

0.8 ps/instruction

0.8 ps/instruction

0.8 ps/instruction

Counters / timers

64/64

128/128

256/256

256/256

h

For / next loops No Yes Yes Yes

Integer math Yes Yes Yes Yes

Real math No Yes Yes Yes

PID No No Yes Yes
Additional Features

High-speed counter 1S/W 1S/W, 2 HIW 1S/W, 2 HIW 1S/W, 2 HIW
Analog adjustments 1 2 2 2

Pulse outputs None 2 2 2
Communication interrupt | 1 transmit/ 1 transmit/1 receivq 1 transmit/2 receivq 2 transmit/4 receive
events 1 receive

Timed interrupts 1 2 2 2

Hardware input interrupts | 1 4 4 4

Real time clock None Yes Yes Yes
Communications

Number of comm ports: 1 (RS-485) 1 (RS-485) 2 (RS-485) 2 (RS-485)

Protocols supported Port (

Port 1:

PPI, Freeport

N/A

PPI, Freeport

N/A

PPI, Freeport, MPI

DP, MPI

PPI, Freeport, MPI

PPI, Freeport, MPI

Peer-to-peer

Slave only

Yes

Yes

Yes

S7-200 Programmable Controller System Manual
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Introducing the S7-200 Micro PLC

1.2

Major Components of the S7-200 Micro PLC

An S7-200 Micro PLC consists of an S7-200 CPU module alone or with a variety of optional
expansion modules.

S7-200 CPU Module

The S7-200 CPU module combines a central processing unit (CPU), power supply, and
discrete 1/O points into a compact, stand-alone device.

The CPU executes the program and stores the data for controlling the automation task or
process.

The power supply provides electrical power for the base unit and for any expansion
module that is connected.

The inputs and outputs are the system control points: the inputs monitor the signals from
the field devices (such as sensors and switches), and the outputs control pumps, motors,
or other devices in your process.

The communications port allows you to connect the CPU to a programming device or to
other devices. Some S7-200 CPUs have two communications ports.

Status lights provide visual information about the CPU mode (RUN or STOP), the current
state of the local /0, and whether a system fault has been detected.

Figures 1-3, 1-4, and 1-5 show the different S7-200 CPU modules.

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02



Introducing the S7-200 Micro PLC

SIEMENS

Figure 1-3 S7-212 CPU Module

SIEMENS

Figure 1-4 S7-214 CPU Module

SIEMENS E E E E E E

Figure 1-5 S7-215 and S7-216 CPU Module

S7-200 Programmable Controller System Manual
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Introducing the S7-200 Micro PLC

Expansion Modules

The S7-200 CPU module provides a certain number of local I/0. Adding an expansion
module provides additional input or output points. As shown in Figure 1-6, the expansion
module comes with a bus connector for connecting to the base unit.

S7-200 CPU Module Expansion Module

SIMATIC
S7-200

Bus Connector

Figure 1-6 CPU Module with an Expansion Module

S7-200 Programmable Controller System Manual
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Installing an S7-200 Micro PLC

The installation of the S7-200 family is designed to be easy. You can use the mounting holes
to attach the modules to a panel, or you can use the built-in clips to mount the modules onto
a standard (DIN) rail. The small size of the S7-200 allows you to make efficient use of space.

This chapter provides guidelines for installing and wiring your S7-200 system.

Chapter Overview

Section Description Page
2.1 Panel Layout Considerations 2-2
2.2 Installing and Removing an S7-200 Micro PLC 2-5
2.3 Installing the Field Wiring 2-§
2.4 Using Suppression Circuits 2-13
25 Power Considerations 2-15

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02 2-1




Installing an S7-200 Micro PLC

2.1

Panel Layout Considerations

Installation Configuration

You can install an S7-200 either on a panel or on a standard rail. You can mount the S7-200
either horizontally or vertically. An I/O expansion cable is also available to add flexibility to
your mounting configuration. Figure 2-1 shows a typical configuration for these types of
installations.

Panel mounting Standard rail mounting

R

Figure 2-1 Mounting Configurations

Clearance Requirements for Installing an S7-200 PLC

2-2

Use the following guidelines as you plan your installation:

* The S7-200 CPU and expansion modules are designed for natural convection cooling.
You must provide a clearance of at least 25 mm (1 in.), both above and below the units,
for proper cooling. See Figure 2-2. Continuous operation of all electronic products at
maximum ambient temperature and load reduces their life.

* For vertical mounting, the output loading may need to be derated because of thermal
constraints. Refer to Appendix A for the data sheet for your particular CPU. If you are
mounting the CPU and modules on a DIN Rail, the DIN rail stop is recommended.

* |f you are installing an S7-200 horizontally or vertically on a panel, you must allow 75 mm
(2.9 in.) for the minimum panel depth. See Figure 2-2.

¢ |f you plan to install additional modules horizontally or vertically, allow a clearance of at
least 25 mm (1 in.) on either side of the unit for installing and removing the module. This
extra space is required to engage and disengage the bus expansion connector.

® Be sure to allow enough space in your mounting design to accommodate the 1/0O wiring
and communication cable connections.

25_mm §
(Lin) Front of the Mounting
enclosure surface
. . -
Clearance for cooling
25mm Sebabababababadadadas
(Lin) VA AAAAAANA
Clearance for removing | 75 mm
expansion /0 module (2.9in.)
Front View Side View

Figure 2-2 Horizontal and Vertical Clearance Requirements for Installing an S7-200 PLC

S7-200 Programmable Controller System Manual
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Installing an S7-200 Micro PLC

Standard Rail Requirements

The S7-200 CPU and expansion modules can be installed on a standard (DIN) rail
(DIN EN 50 022). Figure 2-3 shows the dimensions for this rail.

1.0 mm 35 mm
$ (0.039in.) (1.381n.)
7.5 mm f
(0.291in.) I I

T

Figure 2-3 Standard Rail Dimensions

Panel-Mounting Dimensions

S7-200 CPUs and expansion modules include mounting holes to facilitate installation on

panels. Figures 2-4 through 2-8 provide the mounting dimensions for the different S7-200
modules.

6.4 mm 160 mm
(0.25in) [ (6.3in) ™

6.4 mm 147.3 mm
(0.251in.) _l (5.8in.) - ™

} |®

80 mm 67.3 mm
; i S7-212
(3.151n.) (2.651in.) Mounting holes
l (M4 or no. 8)
ol
Figure 2-4 Mounting Dimensions for an S7-212 CPU Module
6.4 mm 197 mm
(0.251in.) (7.76in.)
6.4 mm |_> 184.3_mm )
(6_25 in) — (7.251in.)
80 mm 67.3 mm
(3.15in.) (2.651n.) S7-214
Mounting holes
2 (M4orno.8)

Figure 2-5 Mounting Dimensions for an S7-214 CPU Module

S7-200 Programmable Controller System Manual
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Installing an S7-200 Micro PLC

26.7 mm ——— 217.3mm -
(1.05in.) (8.561n.)
6.4 mm I—. 178;g_mm EEE——
(0.25in.) (7.26in.)
80 mm S7-215 or
(3.15in) 67.3mm S7-216
(2.65in.) Mounting holes
2 (M4orno.8)
Figure 2-6 Mounting Dimensions for an S7-215 or S7-216 CPU Module

|« 30 mm
(3.541in.)
12.7 mm 77.3 mm
(0.50in) — * k (3.04in) ™
&)
- 8- or 16- 80 mm
E);SJI?;?EM Point ?27(335%”; (3.15in.)
Expansion
® Module &
. T 6.4 mm
Mounting holes — :
(M4 or no. 8) (0.25in.)
Figure 2-7 Mounting Dimensions for an 8- or 16-Point Expansion Module
160 mm
(6.31in.) =
12.7 mm 147.3 mm
(050in) — kﬁ (5.81in.)
? T
L 32-Point 80 mm
EXxistin . 67.3 mm .
CPU O?EM Expansion (2.651in.) (3.15in.)
Module
&) D1
. ? 6.4 mm
Mounting holes — :
(M4 or no. 8) (0.251in.)
Figure 2-8 Mounting Dimensions for a 32-Point Expansion Module
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2.2 Installing and Removing an S7-200 Micro PLC

Mounting an S7-200 Micro PLC on a Panel

/N

Warning
Attempts to install or remove S7-200 modules or related equipment when they are
powered up could cause electric shock.

Failure to disable all power to the S7-200 modules and related equipment during
installation or removal procedures may result in death or serious personal injury, and/or
damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200
modules is disabled before installation.

Use the following procedure for installing an S7-200:

1.

Locate, drill, and tap the mounting holes for DIN M4 or American Standard number 8
screws. Refer to Section 2.1 for mounting dimensions and other considerations.

Secure the S7-200 modules onto the panel, using DIN M4 or American
Standard number 8 screws.

If you are installing an expansion module, use the following steps:

1.

Remove the bus expansion port cover from the existing module housing by inserting a
screwdriver into the space between the bus expansion port cover and the housing, and
gently prying. Ensure that the plastic connecting joints are completely removed. Use
caution not to damage the module. Figure 2-9 shows proper screwdriver placement.

Insert the bus connector into the bus expansion port of the existing module and ensure
that the connector snaps into place.

Ensure that the expansion module is correctly oriented with respect to the CPU module.
If you are using an expansion cable, orient the cable up towards the front of the module.

Connect the expansion module to the bus connector by sliding the module onto the bus
connector so that it snaps into place.

: 20000000000%

A Siemens | ‘

[| s7-200 [ \

SIMATIC
Bus expansion port cover

T

Figure 2-9 Removing the Bus Expansion Port Cover on an S7-200 CPU Module
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Installing an S7-200 Micro PLC onto a Standard Rail

/N

2-6

Warning
Attempits to install or remove S7-200 modules or related equipment when they are
powered up could cause electric shock.

Failure to disable all power to the S7-200 modules and related equipment during
installation or removal procedures may result in death or serious personal injury, and/or
damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200
modules is disabled before installation.

To install the S7-200 CPU module, follow these steps:
1. Secure the rail every 75 mm (3.0 in.) to the mounting panel.

2. Snap open the clip (located on the bottom of the module) and hook the back of the
module onto the rail.

3. Snap the clip closed, carefully checking to ensure that the clip has fastened the module
securely onto the rail.

Note
Modules in an environment with high vibration potential or modules that have been
installed in a vertical position may require DIN rail stops.

If you are installing an expansion module, use the following steps:

1. Remove the bus expansion port cover from the existing module housing by inserting a
screwdriver into the space between the bus expansion port cover and the housing, and
gently prying. Ensure that the plastic connecting joints are completely removed. Use
caution not to damage the module. Figure 2-9 shows proper screwdriver placement.

2. Insert the bus connector into the bus expansion port of the existing module and ensure
that the connector snaps into place.

3. Ensure that the expansion module is correctly oriented with respect to the CPU module.
If you are using an expansion cable, orient the cable up towards the front of the module.

4. Snap open the clip and hook the back of the expansion module onto the rail. Slide the
expansion module onto the bus connector until it snaps into place.

5. Snap the clip closed to secure the expansion module to the rail. Carefully check to
ensure that the clip has fastened the module securely onto the rail.

S7-200 Programmable Controller System Manual
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Removing the S7-200 Modules

Warning
A Attempts to install or remove S7-200 modules or related equipment when they are
powered up could cause electric shock.

Failure to disable all power to the S7-200 modules and related equipment during
installation or removal procedures may result in death or serious personal injury, and/or
damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200
modules is disabled before you install or remove a CPU or expansion module.

To remove the S7-200 CPU module or expansion module, follow these steps:

1. Disconnect all the wiring and cabling that is attached to the module that you are
removing. If this module is in the middle of a chain, the modules to the left or right must
be moved at least 25 mm (1 in.) to allow the bus connector to be disconnected. See
Figure 2-10.

2. Unscrew the mounting screws or snap open the clip, and slide the module at least
25 mm (1 in.) to disengage the bus connector. The bus connector must be disconnected
on both sides of the module.

3.  Remove the module from the panel or rail, and install a new module.

Warning
If you install an incorrect module, the program in the micro PLC could function
unpredictably.

Failure to replace an expansion module and expansion cable with the same model or in
the proper orientation may result in death or serious personal injury, and/or damage to
equipment.

Replace an expansion module with the same model, and orient it correctly. If you are using
an expansion cable, orient the cable up towards the front of the module.

To remove this unit: T

| L |n
>

Move both units at least 25 mm, Or, move this unit at least 25 mm
and disconnect bus connector. and disconnect bus connector.

Figure 2-10  Removing the Expansion Module
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2.3 Installing the Field Wiring

/N

Warning
Attempts to install or remove S7-200 modules or related equipment when they are
powered up could cause electric shock.

Failure to disable all power to the S7-200 modules and related equipment during
installation or removal procedures may result in death or serious personal injury, and/or
damage to equipment.

Always follow appropriate safety precautions and ensure that power to the S7-200
modules is disabled before installing field wiring.

General Guidelines

2-8

The following items are general guidelines for designing the installation and wiring of your
S7-200 Micro PLC:

* Ensure that you follow all applicable electrical codes when wiring the S7-200 Micro PLC.
Install and operate all equipment according to all applicable national and local standards.
Contact your local authorities to determine which codes and standards apply to your
specific case.

* Always use the proper wire size to carry the required current. The S7-200 modules
accept wire sizes from 1.50 mm? to 0.50 mm? (14 AWG to 22 AWG).

* Ensure that you do not overtighten the connector screws. The maximum torque is
0.56 N-m (5 inches-pounds).

* Always use the shortest wire possible (maximum 500 m shielded, 300 m unshielded).
Wiring should be run in pairs, with a neutral or common wire paired with a hot or
signal-carrying wire.

® Separate AC wiring and high-energy, rapidly switched DC wiring from low-energy signal
wiring.
* Properly identify and route the wiring to the S7-200 module, using strain relief for the

wiring as required. For more information about identifying the terminals, see the data
sheets in Appendix A.

* |Install appropriate surge suppression devices for any wiring that is subject to lightning
surges.

* External power should not be applied to an output load in parallel with a DC output point.
This may cause reverse current through the output, unless a diode or other barrier is
provided in the installation.

Warning
Control devices can fail in an unsafe condition, resulting in unexpected operation of
controlled equipment.

Such unexpected action could result in death or serious personal injury, and/or equipment
damage.

Consider using an emergency stop function, electromechanical overrides, or other
redundant safeguards that are independent of the programmable controller.

S7-200 Programmable Controller System Manual
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Grounding and Circuit Reference Point Guidelines for Using Isolated Circuits

The following items are grounding and circuit guidelines for using isolated circuits:

You should identify the reference point (0 voltage reference) for each circuit in the
installation, and the points at which circuits with possible different references can connect
together. Such connections can result in unwanted current flows that can cause logic
errors or can damage circuits. A common cause of different reference potentials is
grounds which are physically separated by long distances. When devices with widely
separated grounds are connected with a communication or sensor cable, unexpected
currents can flow through the circuit created by the cable and the ground. Even over
short distances, load currents of heavy machinery can cause differences in ground
potential or can directly induce unwanted currents by electromagnetic induction. Power
supplies that are improperly referenced with respect to each other can cause damaging
currents to flow between their associated circuits.

S7-200 products include isolation boundaries at certain points to help prevent unwanted
current flows in your installation. When you plan your installation, you should consider
where these isolation boundaries are, and where they are not provided. You should also
consider the isolation boundaries in associated power supplies and other equipment, and
where all associated power supplies have their reference points.

You should choose your ground reference points and use the isolation boundaries
provided to interrupt unneeded circuit loops that could allow unwanted currents to flow.
Remember to consider temporary connections which may introduce a new circuit
reference, such as the connection of a programming device to the CPU.

When locating grounds, you must also consider safety grounding requirements and the
proper operation of protective interrupting devices.

The following descriptions are an introduction to general isolation characteristics of the
S7-200 family, but some features may be different on specific products. Consult the data
sheet in Appendix A for your product for specifications of which circuits include isolation
boundaries and the ratings of the boundaries. Isolation boundaries rated less than1,500 VAC
are designed as functional isolation only, and should not be depended on as safety
boundaries.

CPU logic reference is the same as DC sensor supply M.

CPU logic reference is the same as the input power supply M on a CPU with DC power
supply.
CPU communication ports have the same reference as CPU logic (except DP ports).

Analog inputs and outputs are not isolated from CPU logic. Analog inputs are full
differential to provide low voltage common mode rejection.

CPU logic is isolated from ground to 100 VDC.

DC digital inputs and outputs are isolated from CPU logic to 500 VAC.

DC digital I/0O groups are isolated from each other by 500 VAC.

Relay outputs, AC outputs, and AC inputs are isolated from CPU logic to 1,500 VAC.
AC and relay output groups are isolated from each other by 1,500 VAC.

AC power supply line and neutral are isolated from ground, the CPU logic, and all I/0 to
1500 VAC.

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02 2-9



Installing an S7-200 Micro PLC

Using the Optional Field Wiring Connector

The optional field wiring fan-out connector (Figure 2-11) allows for field wiring connections to
remain fixed when you remove and re-install the S7-200. Refer to Appendix G for the order
number.

Field Wiring

Fan-out Connector

QO OO0O000OOO0OO

AC VAC
OUTPUTS 1L 00 01 02 2L 03 04 05 N L1 85-264

Figure 2-11  Optional Field Wiring Connector

Guidelines for AC Installation
The following items are general wiring guidelines for AC installations. Refer to Figure 2-12.

* Provide a single disconnect switch (1) that removes power from the CPU, all input
circuits, and all output (load) circuits.

* Provide overcurrent devices (2) to protect the CPU power supply, the output points, and
the input points. You can also fuse each output point individually for greater protection.
External overcurrent protection for input points is not required when you use the 24 VDC
sensor supply (3) from the Micro PLC. This sensor supply is short-circuit protected.

® Connect all S7-200 ground terminals to the closest available earth ground (4) to provide
the highest level of noise immunity. It is recommended that all ground terminals be
connected to a single electrical point. Use 14 AWG or 1.5 mm?2 wire for this connection.

* DC sensor supply from the base unit may be used for base unit inputs (5), expansion DC
inputs (6), and expansion relay coils (7). This sensor supply is short-circuit protected.

PR AN
N
PE
(4=
© L o ]
|
0‘ o o o 0‘ lbbﬂ‘
PS
,DI“ N'I ‘I; ié-/%OCO/RIy E:\/I 221 DC Eﬁ 222 Rly
|
G/

Figure 2-12  120/230 VAC Using a Single Overcurrent Switch to Protect the CPU and Load Wiring
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Guidelines for DC Installation

The following items are general wiring guidelines for isolated DC installations. Refer to
Figure 2-13.

Provide a single disconnect switch (1) that removes power from the CPU, all input
circuits, and all output (load) circuits.

Provide overcurrent devices to protect the CPU power supply (2), the output points (3),
and the input points (4). You can also fuse each output point individually for greater
protection. External overcurrent protection for input points is not required when you use
the 24 VDC sensor supply from the Micro PLC. This sensor supply is current limited
internally.

Ensure that the DC power supply has sufficient surge capacity to maintain voltage during
sudden load changes. External capacitance (5) may be required.

Equip ungrounded DC power supplies with a resistor and a capacitor in parallel (6) from
the power source common to protective earth ground. The resistor provides a leakage
path to prevent static charge accumulations, and the capacitor provides a drain for high
frequency noise. Typical values are 1 MQ and 4,700 pf. You can also create a grounded
DC system by connecting the DC power supply to ground (7).

Connect all S7-200 ground terminals to the closest available earth ground (8) to provide
the highest level of noise immunity. It is recommended that all ground terminals be
connected to a single electrical point. Use 14 AWG or 1.5 mm2 wire for this connection.

Always supply 24 VDC circuits from a source that provides safe electrical separation from
120/230 VAC power and similar hazards.

The following documents provide standard definitions of safe separation:

PELV (protected extra low voltage) according to EN60204-1
Class 2 or Limited Voltage/Current Circuit according to UL 508

6] Floating (6) or Grounded (7)
L1 —
N
PE

AC T T
ARS CEL
- P T o
4 (2

@
o

IDOD ® 58 > > @ > > ¢
DO DI
DI S7-200 EM 222 EM 221
s e DC/DC/DC DC DC
T T
4 @ / /

24VDC L+ M

Figure 2-13  Isolated DC System Installation
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Guidelines for North American Installation

2-12

The following items are general wiring guidelines for installations in North America where
multiple AC voltages are present. Refer to Figure 2-14 as you read these guidelines.

Provide a single disconnect switch (1) that removes power from the CPU, all input

circuits, and all output (load) circuits.

Provide overcurrent devices to protect the CPU power supply (2), the output points (3),
and the input points (4). You may also fuse each output point individually for greater

protection.

Make AC power connections to the CPU power supply, AC output driven loads, and
relay-driven loads either line-to-grounded neutral (5) or line-to-line (6).

Connect all S7-200 ground terminals to the closest available earth ground (7) to provide
the highest level of noise immunity. It is recommended that all ground terminals be
connected to a single electrical point. Use 14 AWG or 1.5 mm?2 wire for this connection.

Caution

Line-to-line voltages in power systems with 230 VAC nominal line-neutral voltages will
exceed the voltage rating of the S7-200 power supply, inputs, and outputs.

Exceeding the voltage may cause failure of the S7-200 and connected equipment.

Do not use line-to-line connections where the voltage rating of your S7-200 module is

exceeded.
120 VAC power to CPU and inputs
(1) 120 VAC and 220 VAC load outputs
L1 _
L2
N
PE
(3) (2) (2)
© R Aw  BA
(5)
® * L e o L] > ‘ e o ‘
DO P/S
S7-200 DI DO
‘P|’ ACIACIAC EM221AC EM 222AC
|

Figure 2-14  AC System Installation
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2.4  Using Suppression Circuits

General Guidelines

Equip inductive loads with suppression circuits that limit voltage rise on loss of power. Use
the following guidelines to design adequate suppression. The effectiveness of a given design
depends on the application, and you must verify it for a particular use. Be sure all
components are rated for use in the application.

Protecting DC Transistors

The S7-200 DC transistor outputs contain zener diodes that are adequate for many
installations. Use external suppression diodes for either large or frequently switched
inductive loads to prevent overpowering the internal diodes. Figures 2-15 and 2-16 show
typical applications for DC transistor outputs.

SO
1
+VDC |(/3 (1) IN4001 diode or
< equivalent
()
Inductor
Figure 2-15  Diode Suppression
0 1
+vDC (1) ) (1) IN4001 diode or
equivalent
(2) 8.2V zener,5W
Y Y Y M
()
Inductor

Figure 2-16  Zener Diode Suppression

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02 2-13



Installing an S7-200 Micro PLC

Protecting Relays That Control DC Power

Resistor/capacitor networks, as shown in Figure 2-17, can be used for low voltage (30 V) DC
relay applications. Connect the network across the load.

— v
_ Ypc
(1) R=7,
R c i where minimum R =12 Q
E 3 i i _ +VDC
—0— C=IK
Inductor T where K is 0.5 puF/A to 1 puF/A

Figure 2-17  Resistor/Capacitor Network on Relay-Driven DC Load

You can also use diode suppression, as shown in Figures 2-15 and 2-16, for DC relay
applications. A threshold voltage of up to 36 V is allowed if you use a reverse zener diode.

Protecting Relays and AC Outputs That Control AC

When you use a relay or AC output to switch 115 V/230 VAC loads, place resistor/capacitor
networks across either the relay contacts or the AC outputs as shown in Figure 2-18. You
can also use a metal oxide varistor (MOV) to limit peak voltage. Ensure that the working
voltage of the MOV is at least 20% greater than the nominal line voltage.

O
R > 0.5 x Vrms for relay,
R MOV 10 Q minimum for AC outputs.
0 C =0.002 pF to 0.005 pF for each
C 10 VA of steady-state load.
Inductor

Figure 2-18  AC Load with Network across Relay or AC Outputs

The capacitor allows leakage current to flow around the open switch. Be sure that the
leakage current, | (leakage) = 2 x 3.14 x f x C x Vrms, is acceptable for the application.

For example: A NEMA size 2 contactor lists 183 VA coil inrush and 17 VA sealed coil load. At
115 VAC, the inrush current is 183 VA/115 V = 1.59 A, which is within the 2A switching
capability of the relay contacts.

The resistor = 0.5 x 115 = 57.5 Q; choose 68 Q as a standard value.
The capacitor = (17 VA/10) x 0.005 = 0.0085 pF; choose 0.01 pF as the value.
The leakage current = 2 x 3.14 x 60 x 0.01 x 106 x 115 = 0.43 mA rms.

S7-200 Programmable Controller System Manual
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2.5 Power Considerations

The S7-200 base units have an internal power supply that provides power for the base unit,
the expansion modules, and other 24 VDC user power requirements. Use the following
information as a guide for determining how much power (or current) the base unit can
provide for your configuration.

Power Requirements
Each S7-200 CPU module supplies both 5 VDC and 24 VDC power:

® Each CPU module has a 24 VDC sensor supply that can supply 24 VDC for local input
points or for relay coils on the expansion modules. If the power requirement for 24 VDC
exceeds the power budget of the CPU module, you can add an external 24 VDC power
supply to provide 24 VDC to the expansion modules.

* The CPU module also provides 5 VDC power for the expansion modules when an
expansion module is connected. If the 5 VDC power requirements for expansion modules
exceeds the power budget of the CPU module, you must remove expansion modules
until the requirement is within the power budget.

Warning

A Connecting an external 24 VDC power supply in parallel with the S7-200 DC Sensor
Supply can result in a conflict between the two supplies as each seeks to establish its own
preferred output voltage level.

The result of this conflict can be shortened lifetime or immediate failure of one or both
power supplies, with consequent unpredictable operation of the PLC system.
Unpredictable operation could result in death or serious injury to personnel, and/or
damage to equipment and property.

The S7-200 DC Sensor Supply and any external power supply should provide power to
different points. A single connection of the commons is allowed.

The data sheets in Appendix A provide information about the power budgets of the CPU
modules and the power requirements of the expansion modules.
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Calculating a Sample Power Requirement

2-16

Table 2-1 shows a sample calculation of the power requirements for an S7-200 Micro PLC
that includes the following modules:

e CPU 214 DC/DC/DC
* Three EM 221 Digital Input 8 x DC 24 V expansion modules
* Two EM 222 Digital Output 8 x Relay expansion modules

The CPU in this example provides sufficient 5 VDC current for the expansion modules;
however, it requires an additional power supply to provide the 24 VDC power requirement.
(The I/O requires 448 mA of 24 VDC power, but the CPU provides only 280 mA.) Appendix B
provides a blank power calculation table.

Table 2-1 Power Budget Calculations for a Sample Configuration
CPU Power Budget 5VDC 24 VDC
CPU 214 DC/DC/DC 660 mA 280 mA
minus
System Requirements 5VDC 24 VDC
CPU 214 DC/DC/DC BASE UNIT 14 inputx 7mA = 98 mA
Three EM 221 expansion modules| 3 x 60 mA = 180 mA| 3 x 60 mA = 180 mA
Two EM 222 expansion modules |2 x 80 mA = 160 mA[ 2 x 85 mA = 170 mA
Total Requirement 340 mA 448 mA
equals
Current Balance 5VDC 24 VDC
Current Balance Total 320 mA [168 mA]
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Installing and Using the STEP 7-Micro/WIN
Software

This manual describes Version 2.1 of STEP 7-Micro/WIN. Previous versions of the software
may operate differently.

STEP 7-Micro/WIN is a Windows-based software application that supports both the 16-bit
Windows 3.1 environment (STEP 7-Micro/WIN 16) and the 32-bit Windows 95 and
Windows NT environments (STEP 7-Micro/WIN 32). In order to use STEP 7-Micro/WIN, the
following equipment is recommended:

Recommended: a personal computer (PC) with an 80586 or greater processor and
16 Mbytes of RAM, or a Siemens programming device (such as a PG 740); minimum
computer requirement: 80486 processor with 8 Mbytes

One of the following sets of equipment:

— A PC/PPI cable connected to your communications port (PC COM1 or COM2)

— A communications processor (CP) card and multipoint interface (MPI) cable

— A multipoint interface (MPI) card (A communications cable comes with the MPI card.)
VGA monitor, or any monitor supported by Microsoft Windows

At least 50 Mbytes of free hard disk space

Microsoft Windows 3.1, Windows for Workgroups 3.11, Windows 95, or Windows NT 4.0
or greater

Optional but recommended: any mouse supported by Microsoft Windows

STEP 7-Micro/WIN provides extensive online help. Use the Help menu command or press
F1 to obtain the most current information.

Chapter Overview

Section Description Page
3.1 Installing the STEP 7-Micro/WIN Software 3-Z
3.2 Using STEP 7-Micro/WIN to Set Up the Communications Hardware 3-4
33 Establishing Communication with the S7-200 CPU 3-7
3.4 Configuring the Preferences for STEP 7-Micro/WIN 3-25
3.5 Creating and Saving a Project 3-26
3.6 Creating a Program 3-27
3.7 Creating a Data Block 3-32
3.8 Using the Status Chart 3-34
3.9 Using Symbolic Addressing 3-36
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3.1

Installing the STEP 7-Micro/WIN Software

Pre-Installation Instructions

Before running the setup procedure, do the following:

If a previous version of STEP 7-Micro/WIN is installed, back up all STEP 7-Micro/WIN
projects to diskette.

Make sure all applications are closed, including the Microsoft Office toolbar.

Installation may require that you restart your computer.

Installation Instructions for Windows 3.1

If you have Windows 3.1 (Windows for Workgroups 3.11) on your machine, use the following
procedure to install the STEP 7-Micro/WIN 16 software:

1.
2.
3.

Start by inserting Disk 1 in the disk drive of your computer (usually drive A or drive B).
From the Program Manager, select the menu command File » Run...

In the Run dialog box, type a:\setup  and click “OK” or press ENTER. This starts the
setup procedure.

Follow the online setup procedure to complete the installation.

Installation Instructions for Windows 95 or Windows NT 4.0

3-2

If you have Windows 95 or Windows NT 4.0 on your machine, use the following procedure to
install the STEP 7-Micro/WIN 32 software:

1.

2
3.
4

o

Start by inserting Disk 1 in the disk drive of your computer (usually drive A or drive B).
Click once on the “Start” button to open the Windows 95 menu.
Click on the Run... menu item.

In the Run dialog box, type a:\setup  and click on “OK” or press ENTER. This starts the
setup procedure.

Follow the online setup procedure to complete the installation.

At the end of the installation, the Install/Remove Modules dialog box appears
automatically. See Figure 3-1. You can install the hardware for your machine to
communicate now (see Section 3.2), or you can wait until later (see Section 3.3).
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Instal/Remove Modules n
Selection: Installed:
CPU5411 MPI-ISA Card

CPU5511 (Plug & Play)
CPU5611 (Plug & Play)
MPI-ISA on board

PC Adapter (PC/MPI-Cable)

PC/PPI cable

Install -->
<-- Remove

This button appears

REsGlEEs <«—] if you are using a

Windows NT

| MPI/PROFIBUS Card for PC

operating system.

Close

Help

Figure 3-1

Troubleshooting the Installation

Install/Remove Modules Dialog Box

The following situations can cause the installation to fail:

Not enough memory: at least 50 Mbytes of free space are required on your hard disk.
Bad diskette: verify that the diskette is bad, then call your salesman or distributor.

Operator error: start over and read the instructions carefully.

Failure to close any open applications, including the Microsoft Office toolbar

Review the READMEX.TXT file included on your diskettes for the most recent information
about STEP 7-Micro/WIN. (In the x position, the letter A= German, B = English, C = French,

D = Spanish, E = Italian.)
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3.2

General Information for Installing or Removing the Communications Hardware

Using STEP 7-Micro/WIN to Set Up the Communications Hardware

If you are using Windows 95 or Windows NT 4.0, the Install/Remove Modules dialog box
appears automatically at the end of your software installation. See Figure 3-1. If you are
using Windows 3.1, follow these steps:

1.

Select the menu command Setup » Communications... . The Communications dialog

box appears.

Click the “PG/PC Interface...” button. The Setting the PG/PC Interface dialog box

appears.

Click the “Install...” button. The Install/Remove Modules dialog box appears. See

Figure 3-1.

You will need to base your installation of communications hardware on the following criteria:

Table 3-1 shows the possible hardware configurations and baud rates that

The operating system that you are using (Windows 3.1, Windows 95, or Windows NT 4.0)

The type of hardware you are using, for example:
— PC with PC/PPI cable

— PC or SIMATIC programming device with multipoint interface (MPI) or
communications processor (CP) card

— CPU 212, CPU 214, CPU 215, CPU 216

— Modem

The baud rate you are using

STEP 7-Micro/WIN supports, depending on the type of CPU that you are using. For more
detailed information on communications setup, see Section 3.3.

Table 3-1 Hardware Configurations Supported by STEP 7-Micro/WIN
Type of CPU | STEP 7-Micro/ | Hardware Supported | Baud Rates Operating Type of
WIN Version Supported System Parameter Set
CPU 212, Micro/WIN 16 | PC/PPI cable, MPI-ISA 9.6 kbaud or | Windows 3.1 PPI,
CPU 214, card 19.2 kbaud PPI multi-master|
CPU 216 Windows 95 or | PPI
CPU 215 port 0 Windows NT
Micro/WIN 32 | PC/PPI cable, MPI-ISA 9.6 kbaud or | Windows 95 or | PPI,
card, MPI-ISA card on| 19.2 kbaud | Windows NT PPI multi-master|
board, CP 5411,
CP 5511, CP 5611
CPU 215 port 1 Micro/WIN 16 | Not supported Not supported Windows 3.1 Not supported
(DP port) Windows 95 or
Windows NT
Micro/WIN 32 | MPI-ISA card, 9.6 kbaud to | Windows 95 or | MPI

MPI-ISA card on
board, CP 5411,

CP 5511, CP 5611

12 Mbaud

Windows NT
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Note
STEP 7-Micro/WIN 16 does not support the multi-master parameter set under the
Windows 95 or Windows NT 4.0 operating system.

The following hardware configurations are possible:

e CPU 212, CPU 214, CPU 216, CPU 215 (port 0)
— PC/PPI Cable (PPI), 9.6 kbaud or 19.2 kbaud
— MPI Card (PPI), 9.6 kbaud or 19.2 kbaud

e CPU 215 (port 1, that is, the DP port)
MPI Card (MPI), 9.6 kbaud to 12 Mbaud

Note
STEP 7-Micro/WIN 16 does not support communications on port 1 of the CPU 215.

The selections for MPI Card are different for STEP 7-Micro/WIN 16 and
STEP 7-Micro/WIN 32.

On the left side of the Install/Remove Modules dialog box is a list of hardware types that you
have not installed yet (see Figure 3-1). On the right side is a list of currently installed
hardware types. If you are using the Windows NT 4.0 operating system, there is a
“Resources” button under the Installed list box.

To install the hardware, follow these steps:

1. From the Selection list box, select the hardware type that you have. A description of your
selection is shown in the lower window.

2. Click the “Install -->" button.

To remove hardware, follow these steps:

1. Select the hardware from the Installed list box on the right.
2. Click the “<-- Remove” button.

When you are finished installing or removing hardware, click the “Close” button. This action
returns you to the Setting the PG/PC Interface dialog box. The selections that you made
appear now in the list box that contains the module parameter sets. See Figure 3-7.

For detailed information on the communications setup for your configuration, see
Section 3.3.
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Special Hardware Installation Information for Windows NT Users

3-6

Installing hardware modules under the Windows NT operating system is slightly different
from installing hardware modules under Windows 95. Although the hardware modules are
the same for either operating system, installation under Windows NT requires more
knowledge of the hardware that you want to install. Windows 95 tries automatically to set up
system resources for you; however, Windows NT does not. Windows NT provides you with
default values only. These values may or may not match the hardware configuration.
However, these parameters can be modified easily to match the required system settings.

When you have installed a piece of hardware, select it from the Installed list box and click the
“Resources” button. The Resources dialog box appears. See Figure 3-2. The Resources
dialog box allows you to modify the system settings for the actual piece of hardware that you
installed. If this button is unavailable (gray), you do not need to do anything more.

At this point you may need to refer to your hardware manual to determine the setting for each
of the parameters listed in the dialog box, depending on your hardware settings. You may
need to try several different interrupts in order to establish communication correctly.

For detailed information on the communications setup for your configuration, see
Section 3.3.

Resources - MPI-ISA Card<Board 1> E

Memory Range: #000CC000-000CC7FF B

Input/Output Range: |

Interrupt Request: #15 E'
Direct Memory Access: E'

#- Current hardware setting
* - Possible conflict with other hardware

cancel elp

Figure 3-2 Resources Dialog Box for Windows NT

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02



Installing and Using the STEP 7-Micro/WIN Software

3.3 Establishing Communication with the S7-200 CPU

You can arrange the S7-200 CPUs in a variety of configurations to support network
communications. You can install the STEP 7-Micro/WIN software on a personal computer
(PC) that has a Windows 3.1x, Windows 95, or Windows NT operating system, or you can
install it on a SIMATIC programming device (such as a PG 740). You can use the PC or the
programming device as a master device in any of the following communications
configurations:

* A single master device is connected to one or more slave devices. See Figure 3-3.

* Asingle master device is connected to one or more slave devices and one or more
master devices. See Figure 3-4 and Figure 3-5.

* A CPU 215 functions as a remote I/O module owned by an S7-300 or S7-400
programmable logic controller or by another PROFIBUS master. See Figure 3-13.

* Asingle master device is connected to one or more slave devices. This master device is
connected by means of 11-bit modems to either one S7-200 CPU functioning as a slave
device or else to a network of S7-200 CPUs functioning as slave devices. See
Figure 3-14.

Connecting Your Computer to the S7-200 CPU Using the PC/PPI Cable

Figure 3-3 shows a typical configuration for connecting your personal computer to your CPU
with the PC/PPI cable. To establish proper communications between the components, follow
these steps:

1. Setthe DIP switches on the PC/PPI cable for the baud rate.

2. Connect the RS-232 end of the PC/PPI cable labeled PC to the communications port of
your computer, either COM1 or COM2, and tighten the connecting screws.

3. Connect the other end (RS-485) of the PC/PPI cable to the communications port of the
CPU, and tighten the connecting screws.

For the technical specifications of the PC/PPI cable, see Section A.40; for its order number,
see Appendix G.

DIP switch settings (down = 0, up = 1):
0100 =9600 baud (shown)
001 0=19200 baud

A

S7-200 CPU

 meems |
i

PC/PPI cable

Figure 3-3 Communicating with a CPU in PPl Mode
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Figure 3-4 shows a configuration with a personal computer connected to several S7-200
CPU modules. STEP 7-Micro/WIN is designed to communicate with one S7-200 CPU at a
time; however, you can access any CPU on the network. The CPU modules in Figure 3-4
could be either slave or master devices. The TD 200 is a master device. For detailed
information on network communications, see Chapter 9.

Note

Only STEP 7-Micro/WIN 16 with a Windows 3.1 operating system and
STEP 7-Micro/WIN 32 support multiple masters through the PC/PPI cable;
STEP 7-Micro/DOS does not.

S7-200 CPU S7-200 CPU S7-200 CPU
Station 2 Station 3 Station 4

| | |

Station 0

T
T

RS-485 TD 200 )
) PC/PPI Cable O A
ooog DvD

Figure 3-4 Using a PC/PPI Cable for Communicating with Several S7-200 CPU Modules

Connecting Your Computer to the S7-200 CPU Using the MPI or CP Card

You can use STEP 7-Micro/WIN with a multipoint interface (MPI) or communications
processor (CP) card. Either card provides a single RS-485 port for connection to the network
using an MPI cable. STEP 7-Micro/WIN 32 (the 32-bit version) supports the MPI parameter
set for an MPI network; STEP 7-Micro/WIN 16 (the 16-bit version) does not. After
establishing MPI communications, you can connect STEP 7-Micro/WIN on a network that
contains other master devices. Each master must have a unique address. Figure 3-5 shows
a sample network with master and slave devices. For detailed information on network
communications, see Chapter 9. For information on the MPI card and the various CP cards
that are available, see Section 9.4. Appendix G lists their order numbers.

Note

If you are using the PPl parameter set, STEP 7-Micro/WIN does not support two different
applications running on the same MPI or CP card at the same time. Close the other
application before connecting STEP 7-Micro/WIN to the network through the MPI or CP
card.

S7-200 Programmable Controller System Manual
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Master devices
j TH ) TD 200 OP15 CPU 214
[ — —
Coe D) (D K
MPI or CP card 000 83308 8088
0000 oooo
0000 oooo
MPI cable
(RS-485) CPU 212 | CPU 214 | CPU 212 | CPU 214 |
Slave devices i ;E;ﬂ i;; i;“ﬂ

Figure 3-5 Example of an MPI or CP Card with Master and Slave Devices

From What Point Do | Set Up Communications?

Depending on the operating system that you are using, you can set up communications from
any of the following points:

¢ Under Windows 3.1
Within STEP 7-Micro/WIN 16 only
¢ Under Windows 95 or Windows NT 4.0
— During the final step of the installation (see Section 3.1)
— From the Setting the PG/PC Interface icon, found in the Windows Control Panel
—  Within STEP 7-Micro/WIN 32

S7-200 Programmable Controller System Manual
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Setting Up Communications within STEP 7-Micro/WIN

Within STEP 7-Micro/WIN there is a Communications dialog box that you can use to
configure your communications setup. See Figure 3-6. You can use one of the following
ways to find this dialog box:

® Select the menu command Setup » Communications... .

® Create a new project and click the “Communications...” button in the CPU Type dialog
box.

* If you have a project open, select the menu command CPU » Type... and click the
“Communications...” button in the CPU Type dialog box.

&N STEP 7-Micro/WIN

Project View CPU Setup Help
|@I Al sl —Mesleall ol M sl NS4 oA Mzl 17 (222210 21

Communications n

r Current Communication Settings " PG/PC Interface I
Module Parameter | PC/PPI cable (PPI)

Local Station Address 0 Modem Sewp... |
Transmission Rate 9.6 kbps
COM Port 2

Remote Station Address | 2 Test Setup |

Figure 3-6  Setting Up the Communications between Programming Device or PC and the CPU

After you have called up the Communications dialog box, click the “PG/PC Interface...”
button. The Setting the PG/PC Interface dialog box appears. See Figure 3-7.

S7-200 Programmable Controller System Manual
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| STEP 7- Mlcro/WIN [ = x|

Erolect View
Settmg the PG/PC Interface
Access Path |

Access Point of Application:

Micro/WIN |~ |

(Standard for Micro/WIN)

Module Parameter Set Used:
[MPI-ISA Card(PPI) Properties...

<None>
MPI-ISA Card(MPI)

MPI-ISA Card(PPI) Co

MPI-ISA CardiPROFIBUSi _ Copy.. |
PPI cable(PPI) Delete
(Assigning Parameters to an MPI-ISA Card

for a PPI Network)

Modules

Install...
| OK Cancel | Help |

Figure 3-7 Setting the PG/PC Interface Dialog Box

Setting Up Communications from the Windows Control Panel

S7-200 Programmable Controller System Manual
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If you are using the Windows 95 or Windows NT 4.0 operating system, you can set up the
communications configuration by means of the Control Panel. From the Control Panel, select
the Setting the PG/PC Interface icon. See Figure 3-8.

X Control Panel
File Edit View Help

Setting the PG/PC
Interface

Figure 3-8 Control Panel with Setting the PG/PC Interface Icon
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Setting Up Communications during Installation

Under the Windows 95 or Windows NT 4.0 operating system, at the end of the
STEP 7-Micro/WIN installation, the Communications dialog box appears automatically. You
can set up your configuration at that time, or later.

Selecting the Correct Module Parameter Set and Setting It Up

When you have reached the Setting the PG/PC Interface dialog box (see Figure 3-7), you
must select “Micro/WIN” in the Access Point of Application list box in the Access Path tab.
This dialog box is common to several different applications, such as STEP 7 and WinCC, so
you must tell the program the application for which you are setting parameters.

When you have selected “Micro/WIN” and have installed your hardware, you need to set the
actual properties for communicating with your hardware. The first step is to determine the
protocol that you want to use on your network. See Table 3-1 or Chapter 9 to find out what
your CPU supports and what you should use for your configuration. In most cases, you will
use the PPI protocol for all of your CPU modules, except for the high-speed port (DP port) on
the CPU 215. This port uses the MPI protocol.

When you have decided what protocol you want to use, you can choose the correct setup
from the Module Parameter Set Used list box in the Setting the PG/PC Interface dialog box.
This box lists each hardware type that you have installed, along with the protocol type in
parentheses. For example, a simple setup might require you to use the PC/PPI cable to
communicate with a CPU 214. In this case, you select “PC/PPI cable(PPI).” Another example
is a setup that requires communicating with a CPU 215 through its high-speed port (DP port)
by means of a plain MPI-ISA card that you have installed in your computer. In this case, you
select “MPI-ISA Card(MPI).”

After you have selected the correct module parameter set, you must set up the individual
parameters for the current configuration. Click the “Properties...” button in the Setting the
PG/PC Interface dialog box. This action takes you to one of several possible dialog boxes,
depending on the parameter set that you selected. The sections that follow describe each of
these dialog boxes in detail.

In summary, to select a module parameter set, follow these steps:

1. Inthe Setting the PG/PC Interface dialog box (see Figure 3-7), select “Micro/WIN” in the
Access Point of Application list box in the Access Path tab.

2. Ensure that your hardware is installed. See Section 3.2.
3. Determine the protocol that you want to use.

4. Select the correct setup from the Module Parameter Set Used list box in the PG/PC
Interface dialog box.

5. Click the “Properties...” button in the Setting the PG/PC Interface dialog box.

From this point, you make selections according to the parameter set that you chose.

Setting Up the PC/PPI Cable (PPI) Parameters

This section explains how to set up the PPI parameters for the following operating systems
and hardware:

* Windows 3.1: PC/PPI cable
®*  Windows 95 or Windows NT 4.0: PC/PPI cable

S7-200 Programmable Controller System Manual
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From the Setting the PG/PC Interface dialog box, if you are using the PC/PPI cable and you
click the “Properties...” button, the properties sheet appears for PC/PPI cable (PPI). See
Figure 3-9.

Follow these steps:

1. Inthe PPI Network tab, select a number in the Local Station Address box. This number
indicates where you want STEP 7-Micro/WIN to reside on the programmable controller
network.

2. Select a value in the Timeout box. This value represents the length of time that you want
the communications drivers to spend to attempt to establish connections. The default
value should be sufficient.

3. Determine whether you want STEP 7-Micro/WIN to participate on a network that has
multiple masters. See Chapter 9 for more information. You can leave the check mark in
the Multiple Master Network box, unless you are using a modem. In that case, the box
cannot be checked because STEP 7-Micro/WIN does not support that functionality.

4. Set the transmission rate at which you want STEP 7-Micro/WIN to communicate over the
network. See Chapter 9, Table 9-1, for valid baud rates for your CPU module.

5. Select the highest station address. This is the address where STEP 7-Micro/WIN stops
looking for other masters on the network.

B STEP 7-Micro/WIN

L={(oJ[E VI[N Setting the PG/PC Interface

EE E Access Path

Properties - PC/PPI Cable (PPI)

PPI Network | Local Connection|

— Station Parameters
Local Station Address: 0]
Timeout: | 1s E|
~ Network Parameters
Multiple Master Network
Transmission Rate: | 9.6 kbps E|
Highest Station Address: 31
OK | Cancel | Standard | Help |
[
| OR T Staraara | Teip T
| T T T T I_

Figure 3-9 PC/PPI Cable (PPI) Properties Sheet, PPl Network Tab
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6. Click the Local Connection tab. See Figure 3-10.

7. Inthe Local Connection tab, select the COM port to which your PC/PPI cable is
connected. If you are using a modem, select the COM port to which the modem is
connected and select the Use Modem check box.

8. Click the “OK” button to exit the Setting the PG/PC Interface dialog.

X\ STEP 7-Micro/WIN

(][ @RVIEWN Setting the PG/PC Interface

EE E Access Path

Properties - PC/PPI Cable (PPI)

PPI Network | Local Connection

COM Port: 2 E'

[ Use Modem

OK | Cancel Standard Help |

| OR T Starara | e I I

Figure 3-10 PC/PPI Cable (PPI) Properties Sheet, Local Connection Tab

Setting Up the MPI Card (PPI) Parameters

3-14

This section explains how to set up the PPI parameters for the following operating systems
and hardware:

*  Windows 3.1: MPI-ISA card (including those found in SIMATIC programming devices)
* Windows 95 or Windows NT 4.0:

— MPI-ISA card

— MPI-ISA card on board (MPI cards for SIMATIC programming devices)

- CP5411

— CP5511

- CP5611

S7-200 Programmable Controller System Manual
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From the Setting the PG/PC Interface dialog box, if you are using any of the MPI or CP cards
listed above along with the PPI protocol, and you click the “Properties...” button, the
properties sheet appears for XXX Card(PPI), where “XXX” stands for the type of card you
installed, for example, MPI-ISA. See Figure 3-11.

Follow these steps:

1. Inthe PPI Network tab, select a number in the Local Station Address box. This number
indicates where you want STEP 7-Micro/WIN to reside on the programmable controller
network.

2. Select a value in the Timeout box. This value represents the length of time that you want
the communications drivers to spend to attempt to establish connections. The default
value should be sulfficient.

3. Determine whether you want STEP 7-Micro/WIN to participate on a network that has
multiple masters. See Chapter 9 for more information. You can leave the check mark in
the Multiple Master Network box.

4. Set the transmission rate at which you want STEP 7-Micro/WIN to communicate over the
network. See Chapter 9, Table 9-1, for valid baud rates for your CPU module.

5. Select the highest station address. This is the address where STEP 7-Micro/WIN stops
looking for other masters on the network.

6. Click the “OK” button to exit the Setting the PG/PC Interface dialog box.

5N STEP 7-Micro/WIN =|=] x|

Project View Cinmmermmmmes
Setting the PG/PC Interface n

Access Path | |
Properties - MPI-ISA Card(PPI) n

PPI Network |

— Station Parameters
Local Station Address: 0]
Timeout: [1s [~

— Network Parameters
Multiple Master Network
Transmission Rate: | 9.6 kbps E|
Highest Station Address: W

OK | Cancel | Standard | Help |

= Semoar——) T T

Figure 3-11  MPI-ISA Card (PPI) Properties Sheet

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02 3-15



Installing and Using the STEP 7-Micro/WIN Software

Setting Up the MPI Card (MPI) Parameters

This section explains how to set up the MPI parameters for the following operating systems
and hardware:

*  Windows 3.1: MPI-ISA card (including those found in SIMATIC programming devices)
® Windows 95 or Windows NT 4.0:

— MPI-ISA card

— MPI-ISA card on board (MPI cards for SIMATIC programming devices)

- CP5411

— CP5511

- CP5611

From the Setting the PG/PC Interface dialog box, if you are using any of the MPI or CP cards
listed above along with the MPI protocol, and you click the “Properties...” button, the
properties sheet appears for XXX Card(MPI), where “XXX" stands for the type of card you
installed, for example, MPI-ISA. See Figure 3-12.

STEP 7-Micro/WIN

Project View Comumm
tting the PG/PC Interface n

BT

lln

Access Path | |
Properties - MPI-ISA Card(MPI) n

MPI Network |
— Station Parameters
Local Station Address: 0]
. [[1 Not the Only Master Active
Make sure that Timeout: [1s
this check box is
empty.
Py ~ Network Parameters
Transmission Rate: | 187.5 kbps E
Highest Station Address: 31 B

OK | Cancel | Standard | Help |

T STrTeeT T TTeTp T I

Figure 3-12  MPI-ISA Card (MPI) Properties Sheet

S7-200 Programmable Controller System Manual
3-16 C79000-G7076-C230-02



Installing and Using the STEP 7-Micro/WIN Software

Follow these steps:

1. Inthe MPI Network tab, select a number in the Local Station Address box. This number
indicates where you want STEP 7-Micro/WIN to reside on the programmable controller
network.

2. Make sure that the Not the Only Master Active check box is cleared, regardless of the
number of masters you have on your network. If the check box contains a check mark,
click the box to clear it. Be sure to connect the communication cable between the
programming device and the CPU before initiating communications. If you start
communications before connecting the programming device to the existing CPU network
including one or more master devices, then communications are disrupted while the
network is being reinitialized.

3. Select a value in the Timeout box. This value represents the length of time that you want
the communications drivers to spend to attempt to establish connections. The default
value should be sufficient.

4. Set the transmission rate at which you want STEP 7-Micro/WIN to communicate over the
network. Because you are probably using the DP port on a CPU 215, you can select any
available transmission rate up to 12 Mbaud. See Chapter 9, Table 9-1, for valid baud
rates for your CPU module.

5. Select the highest station address. This is the address where STEP 7-Micro/WIN stops
looking for other masters on the network.

6. Click the “OK" button to exit the Setting the PG/PC Interface dialog box.

Troubleshooting the MPI Communications Setup for 16-Bit Applications

The MPI Card option activates the MPI drivers in the STDPMPL.INI configuration file, which
was placed in the Windows directory during the STEP 7-Micro/WIN installation.

If you get an interrupt error, you must set the MPI card to a free hardware interrupt request
(IRQ) line. The default interrupt line is IRQ 5. The IRQ field is used to specify the interrupt

number used by the MPI card. An interrupt error indicates that IRQ 5 is already in use. To

specify a different IRQ line, follow these steps:

1. Select the menu command Setup » Communications... . The communications dialog
box is displayed. Locate the hardware interrupt options and choose an alternate value.

2. Accept your changes by clicking “OK” or pressing ENTER. The software automatically
modifies the S7TDPMPL.INI file, and informs you if exiting the application is required.

3. Restart the STEP 7-Micro/WIN application and select the MPI option again.

Note
The following are the default addresses for the S7-200 CPU modules with more than one
communication port:

e CPU215 Port 0: 2
Port 1: 126

e CPU 216 Port 0: 2
Port 1: 2
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Troubleshooting the MPI Communications Setup for Windows NT 4.0

Setting up the MPI card correctly under Windows NT 4.0 is somewhat difficult. If you have
problems with your setup (assuming that you have the MPI card installed in the
communications setup screens), follow these steps:

1.

7.

Make sure you have a working MPI card. There are several ways to do this: you can test
it on a Windows 95 machine or check it under STEP 7-Micro/WIN Version 2.0.

Check the DIP switches on the side of your MPI card to determine how much memory to
reserve for the card. See Table 3-2.

Check to see what resources Windows NT has reserved for the card to make sure that
the reserved resources match the switch configuration. Follow these steps:

a. Open the Setting the PG/PC Interface dialog box.

b. Click the “Install...” button.

c. Select the MPI Card from the Installed list.

d. Click the “Resources” button. This button is available only under Windows NT.

If the resource allocation is correct and your card still does not work, try changing the
hardware interrupt request line to which the card is linked. There may be a conflict with
another piece of hardware. You can use the Resources dialog box to make this change.

If you have gone through every interrupt and the card still does not work, you must
change the DIP switch settings on the card to a different address. Repeat step 3. Repeat
step 4.

If you have tried all of the steps above and your card still does not work, all of your
resources are probably already taken by other pieces of hardware. You can try to
remove or disable some of these other hardware pieces (for example, sound cards) to
try to make some resources available. Then start again with step 2 above.

If all else fails, use a different communications driver.

The documentation that comes with the MPI card explains in more detail the hardware
conflicts that may possibly occur.

Table 3-2 Amount of Memory Required for an MPI Card

SWi1 SW2 SW3 Memory
ON ON ON #000C8000-000C87FF
ON ON OFF #000C9000-000C97FF
ON OFF ON #000CCO000-000CC7FF
ON OFF OFF #000D0000-000D0O7FF
OFF ON ON #000D1000-000D17FF
OFF ON OFF #000DCO000-000DC7FF
OFF OFF ON #000E1000-000E17FF

3-18
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Connecting a CPU 215 as a Remote I/0 Module

You can connect the CPU 215 to a PROFIBUS network, where it can function as a remote
1/0 module owned by an S7-300 or S7-400 programmable logic controller or by another
PROFIBUS master. See Figure 3-13.

The CPU 215 has a port marked as DP on the CPU. Use the DP port to connect your
CPU 215 as a remote I/O module on a PROFIBUS network.

The only setting you must make on the CPU 215 to use it as a PROFIBUS slave is the
station address of the DP port of the CPU. This address must match the address in the
configuration of the master. The master device configures the CPU 215. For more
information about distributed peripheral (DP) standard communications, see Section 9.5.

Programming Device (PG) S7-300 WIEh CPU 315-2 DP as DP master

= g HH CPU 215
0 ®
s ff” il
0 1 J 1 2
0 g
MPI | PROFIBUS
subnet | subnet
e
O Terminating resistor on |

0 to x MPI addresses of the nodes |
0 to x PROFIBUS addresses of the nodes

Figure 3-13  CPU 215 on a PROFIBUS Subnetwork, with MPI Subnetwork

Using Modems to Connect an S7-200 CPU to a STEP 7-Micro/WIN Master

Using STEP 7-Micro/WIN on a PC with a Windows 3.1x, Windows 95, or Windows NT
operating system or on a SIMATIC programming device (such as a PG 740) as a
single-master device, you can make connections to the following S7-200 devices by means
of modems:

* Asingle S7-200 CPU as a slave device
® Multiple S7-200 CPUs as slaves on a network
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3-20

Depending on whether you want to connect to only one S7-200 CPU or to a network of them,
you need the following cables and adapter (see Figure 3-14):

* A cable with RS-232 capability at each end to connect the PC or SIMATIC programming
device to a full-duplex 11-bit modem at one end of the telephone line

* A null modem adapter to connect the modem at the other end of the telephone line to a
PC/PPI cable

* A PC/PPI cable to connect the null modem adapter to either of the following ports:
— The communications port of the S7-200 CPU (see Figure 3-14)

— A Siemens programming port connector on a PROFIBUS network (see Figure 9-3)

RS-232
COMXx

/ FuII-dupI\ex Full-duplex

PG/ ]@i_g_iﬁ 11-bit e 1L-bit F
PC B /Q modem modem

Telephone line Null modem PC/PPI
adapter cable

RS-232

Note: x = your port number Local Remote

Figure 3-14  S7-200 Data Communications Using an 11-Bit Modem

Because these configurations allow only one master device, there is no token passing.
These configurations support only the PPI protocol. In order to communicate through the PPI
interface, the S7-200 programmable logic controller requires that the modem use an 11-bit
data string. The S7-200 controller requires one start bit, eight data bits, one parity bit (even
parity), one stop bit, asynchronous communication, and a transmission speed of 9600 baud
for PPI. Many modems are not capable of supporting this data format. The modem requires
the settings listed in Table 3-3.

Figure 3-15 shows the pin assignments for a null modem adapter. For more information on
network communications using the PC/PPI cable, see Chapter 9.

Table 3-3 Modem Settings Required

Data Format in Bits [ Transmission Speed | Transmission Speed on| Other Features

between Modem and PG the Line
8 data Ignore DTR signal
1 start No hardware flow
9600 gt 9600 g control

1 stop

1 parity (even)
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Null Modem Adapter 25-Pin to 9-Pin Adapter
Modem PC/PPI cable
25-pin 25-pin 25-pin 9-pin

2 2
3 _—— 3

;

CQO~NOUAWN

N
~
(€]

OO ~NOUDWN
L]
[ ]

[T

Figure 3-15  Pin Assignments for a Null Modem Adapter

Setting Up the Communications Parameters When Using Modems

To set up communications parameters between your programming device or PC and the
CPU when using modems, you must use the module parameter set for the PC/PPI cable.
Otherwise, the Configure Modems function is not enabled. Ensure that the Configure
Modems function is enabled and then set up the configuration parameters by following these
steps:

Note

The communications setup described here applies to the Multi Tech

MultiModemzDX MT1932ZDX. If you are not using this type of modem, you must choose
“User-Defined” as the Selected Modem in the Configure Modems dialog box. Your modem
must be an 11-bit modem and must run at 9600 baud. Check the manual for your modem
to determine the parameters to enter in the Configuration tabs of the Configure Modems
dialog box.

1. Select the menu command Setup » Communications... .

In the Communications dialog box, if the Current Protocol area shows “PC/PPI
cable(PPI),” click the “PG/PC Interface...” button and go on to step 3.

If the Current Protocol area does not show “PC/PPI cable(PPI),” click the “PG/PC
Interface...” button and continue with step 2.

2. Inthe Access Path tab, in the Module Parameter Set Used list box, select PC/PPC
cable(PPI). If this selection is not in the list box, you must install it. See Section 3.1.

3. Click the “Properties” button. The PC/PPI cable(PPI) properties sheet appears.
4. Inthe PC/PPI cable(PPI) properties sheet, click the Local Connection tab.

In the COM Port area, ensure that the Use Modem box contains a check mark. If the box
is empty, select it to insert a check mark.

6. Click the “OK” button. The Access Path tab appears again.

7. Click the “OK” button. The Communications dialog box appears again.
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8. Click the “Configure Modems...” button. The Configure Modems dialog box appears.
(You can also access the “Configure Modems...” button by selecting the menu command
Setup » Connect Modem... . The button appears in the Connect dialog box.)

The General Information tab of the Configure Modems dialog box provides the 11-bit data
string requirements for the modems and lists the hardware components that you need.
Figure 3-14 shows the same hardware components.

9. Click the Local Modem Configuration tab. See Figure 3-16.

10. In the Local Modem Configuration tab, in the Selected Modem list box, choose Multi
Tech MultiModemZDX MT1932ZDX.

The only other fields that you can edit in this tab are Connect Phone Number and
Timeout. The time-out is the length of time that the local modem attempts to set up a
connection to the remote modem. If the time indicated in seconds in the Timeout field
elapses before the connection is set up, the attempt to connect fails.

11. If you want to test the configuration of your local modem, click the “Test Modem” button
while the modem is connected to your local machine (your programming device or PC).

12. Disconnect your local modem and connect your remote modem to your local machine
(your programming device or PC).

£ Configure Modems

Local Modem Configuration | Remote Modem Configuration | General Information |
Selected Modem: Connect Phone Number:
Multi Tech MultiModemZDX MT1932ZDX | 5538
— Dial Options Disconnect
Initialize: | AT&FO%E5=1&E12M0X3 (" UseDTP

(* Use Command

Prefix: ATDT Suffix: "M Command:
Timeout: |30 seconds | ATHO

— Command Strings Flow Control

Set 11 Bit Mode: $EB11 Transmitter None
Set Baud Rate: $SB Receiver None

Status:

Program Modem | Test Modem |

OK | Cancel |

Figure 3-16 Local Modem Configuration Tab of the Configure Modems Dialog Box
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13. Click the Remote Modem Configuration tab. See Figure 3-17.

14. In the Remote Modem Configuration tab, in the Selected Modem list box, choose Multi
Tech MultiModemzZDX MT1932ZDX.

15. Click the “Program Modem” button. This action transfers the parameters into a memory
chip in the remote modem.

16. If you want to test your remote modem to see if it is programmed correctly, click the “Test
Modem” button.

17. Click the “OK” button. The Communications dialog box appears again.

I Configure Modems

Local Modem Configuration | Remote Modem Configuration General Information |

Selected Modem:

Multi Tech MultiModemzDX MT1932zDX  |Rd

— Dial Options Disconnect
Initialize: | AT&F0%E5=1&E12M0X3 (" UseDTP
(¢ Use Command
Prefix: ATDT Suffix: M Command:
| ATHO
— Command Strings Flow Control
Set 11 Bit Mode: |$EB11 Transmitter | None E
Set Baud Rate: |$SB Receiver |[None E

Status:

Program Modem | Test Modem |

OK | Cancel |

Figure 3-17 Remote Modem Configuration Tab of the Configure Modems Dialog Box
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3-24

18.

19.
20.
21.

22.

23.

24,

25.

Disconnect your remote modem from your local machine (your programming device or
PC).

Connect the remote modem to your S7-200 programmable controller.
Connect your local modem to your programming device or PC.

Ensure that your setup matches the one shown in the General Information tab of the
Configure Modems dialog box. See also Figure 3-14.

When you have finished your setup, click the “OK” button to exit the Communications
dialog box.

To connect your modem, select the menu command Setup » Connect Modem... . The
Connect dialog box appears. See Figure 3-18.

If you did not already enter a phone number in the Connect Phone Number field of the
Local Modem Configuration tab of the Configure Modems dialog box, or if you want to
change the phone number that you entered there, enter the number in the Phone
Number field.

Click the “Connect” button. Your modem setup is complete.

N STEP 7-Micro/WIN

CoN

Project View CPU Help

- Preferences...
EE E Communications...

Connect Modem...

;.7 Phone Number: | xxx-xxxx
Sy

Configure Modems... |

Connect Cancel

Figure 3-18 Connect Dialog Box
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3.4  Configuring the Preferences for STEP 7-Micro/WIN

Before creating a new project, specify the preferences for your programming environment. To
select your preferences, follow these steps:

1. Select the menu command Setup > Preferences... as shown in Figure 3-19.
2. Select your programming preferences in the dialog box that appears.

3. Confirm your choices by pressing ENTER or clicking the “OK” button.

Note
To enable a change in the Language field shown below, you must exit STEP 7-Micro/WIN

and restart the software.

Project Edit View CPU Debug Tools Window Help

EIEI DIIImI/Ii \Ereferences._

ommunications...

Connect Modem

Preferences

 Default Editor
(" STL Editor

(e Ladder Editor Cancel

~ Mnemonic Set
(e International Language

C SIMATIC | English |

r Initial Window States
[ Maximize All
Program Editor Symbol Table
|Normalized B | Minimized B

Data Block Editor Status Chart
| Minimized -] | Minimized -]

Figure 3-19  Selecting Your Programming Preferences
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3.5

Creating and Saving a Project

Before you create a program, you must create or open a project. When you create a new
project, STEP 7-Micro/WIN opens the following editors:

* Ladder Editor or Statement List Editor (depending on your selected preference)
¢ Data Block Editor

® Status Chart

e Symbol Table

Creating a New Project

The Project menu command allows you to create a new project, as shown in Figure 3-20.
Select the menu command Project » New.... The CPU Type dialog box is displayed. If you
select the CPU type from the drop-down list box, the software displays only those options
which are available for your CPU; if you select “None,” no CPU-specific restrictions are
placed on your program. When you download the program, the CPU notifies you if you have
used options that are not available. For example, if your program uses an instruction that is
not supported by your CPU, the program is rejected.

Note
STEP 7-Micro/WIN does not check the range of parameters. For example, you can enter
VB9999 as a parameter to a ladder instruction even though it is an invalid parameter.

View CPU Setup Help
Ctrl+N
Ctrl+O
CPU Type

Open...

1 c:\microwin\pi
2 ci\microwin\p) Select or read the CPU type from your PLC if you would like the software to
3

limit the available options to only those supported by a specific CPU.
c:\microwin\p) P y pPp y a sp

Exit

CPU Type: [ CPU 214 Read CPU Type |

Communications...

Figure 3-20  Creating a New Project

Saving a Project

3-26

You can save all of the components of your project by selecting the menu command
Project » Save All or by clicking the Save All button:

You can save a copy of the active project to a different name or location by selecting the
menu command Project » Save As....
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3.6 Creating a Program

STEP 7-Micro/WIN allows you to create the user program (OB1) with either the Ladder Editor
or the Statement List Editor.

Entering Your Program in Ladder Logic

The Ladder Editor window allows you to write a program using graphical symbols (see
Figure 3-21). The toolbar includes some of the more common ladder elements used to enter
your program. The first (left) drop-down list box contains instruction categories. You can
access these categories by clicking or pressing F2. After a category is selected, the second
drop-down list contains the instructions specific to that category. To display a list of all
instructions in alphabetical order, press F9 or select the All Instructions category. Or you can
select the View » Instruction Toolbar to display the Ladder Instruction Toolbar.

There are two comments associated with each network as described below.

* Single-line network title comments are always visible in the ladder display, and you can
access these by clicking anywhere in the network title region.

® Multi-line network comments are accessed by double-clicking on the network number
region. Multi-line network comments are only visible through a dialog box, but are printed
on all printouts.

To start entering your program, follow these steps:

1. To enter a program title, select the menu command Edit » Program Title... . Type in your
new program title, then click the “OK” button.

2. To enter ladder elements, select the type of element you want by clicking the
corresponding icon button or selecting it from the instruction list.

3. Type the address or parameter in each text field and press ENTER.

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02 3-27



Installing and Using the STEP 7-Micro/WIN Software

Project Edit View CPU Debug Tools Setup Window Help
DIII‘ /Iﬁlil ;I .I ==

Contacts Fsil HI ;g*l ?G’I ;'I ;’I
e
-
0

Network 1 [T°%, NETWORK TITLE (single line)

Ld

10.0 Double click here to access
the network title and
_| I_ comment editor.

Select the instruction from
the drop down list or the
Instruction Toolbar, and
click to place the element.

~

N

=z
(@)
T T

_|
_|
_|
_|
_|
_|
_|

Z|T

+_
x>/
sl
A
=]

2

¥

-
]

Instruction Toolbar for
the Ladder Editor

|0 L

|

Figure 3-21  Ladder Editor Window
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Entering Your Program in Statement List

The Statement List (STL) Editor is a free-form text editor which allows a certain degree of
flexibility in the way you choose to enter program instructions. Figure 3-22 shows an
example of a statement list program.

B STL Editor - projectl.ob1

/IConveyor Line Program

NETWORK 1 //Start Motor:

LD “Start1” /IWhen 10.0 is on

iAN “E-Stopl” /land 10.1 is not on, To allow viewing of the
= Q0.0 /lthen turn on conveyor motor. program in Ladder,
Network 2 //[E-stop Conveyor: -—— divide s_egments of

LD 10.1 //When E-stop 1 is on code with the keyword
(0] 10.3 /lor when E-stop 2 is on, NETWORK.

R Q0.0,1 /fturn off conveyor motor.

NETWORK 3 //IEnd of Program

MEND

Figure 3-22  STL Editor Window with Sample Program

To enter an STL program, follow these guidelines:

* To be able to view an STL program in ladder, you must divide segments of code into
separate networks by entering the keyword NETWORK. (Network numbers are
generated automatically after you compile or upload the program.) The Network
declarations must come at appropriate boundaries for ladder representation.

® Start each comment with a double slash (/). Each additional comment line must also
begin with a double slash.

* End each line with a carriage return.
® Separate each instruction from its address or parameter with a space or tab.

* Do not use a space between the operand type and the address (for example, enter 10.0 ,
notl 0.0 ).

® Separate each operand within an instruction with a comma, space, or tab.

* Use quotation marks when entering symbol names. For example, if your symbol table
contains the symbol name Startl for the address 10.0 , enter the instruction as follows:

LD “Start1”

Compiling the Program

After completing a network or series of networks, you can check the syntax of your code by
selecting the menu command CPU » Compile or by clicking the Compile button.
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Downloading Your Program

3-30

After completing your program, you can download the project to the CPU. To download your
program, select the menu command Project » Download... or click the Download button in

the main window.
min|

The Download dialog box that appears allows you to specify the project components that
you want to download, as shown in Figure 3-23.

:—j» STEP 7-Micro/WIN - c:\microwin\projectl.prj

Edit View CPU Debug Tools Setup Window Help
Ctrl+N
Ctrl+O

Ctrl+S Download

Program Code Block

Gl Data Block
Ctrl+D . .
CPU Configuration

Page Setup...

Print Preview...

Print... Ctrl+P
Print Setup...

Exit

Figure 3-23  Downloading Project Components to the CPU

* Program Code Block (OB1) contains your program logic to be executed by the CPU.
¢ Data Block (DB1) contains the initialization values to be used by your program.

®* CPU Configuration (CFG) contains the system setup information, which includes
communication parameters, retentive ranges, input filter selections, password, and output
table definitions.

Click the “OK” button or press ENTER to confirm your choices and to execute the download
operation.
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Viewing a Program in Ladder Logic or Statement List

You can view a program in either ladder or STL by selecting the menu command View » STL
or View » Ladder, as shown in Figure 3-24.

When you change the view from STL to ladder and back again to STL, you may notice
changes in the presentation of the STL program, such as:

* |[nstructions and addresses are changed from lower case to upper case.
® Spaces between instructions and addresses are replaced with tabs.

You can accomplish the same formatting of the STL instructions by selecting the menu
command CPU » Compile while the STL Editor is active.

Note

Certain combinations of statement list instructions cannot be converted successfully to
ladder view. In that case, the message “lllegal Network” marks the section of code that
cannot be represented in ladder.

5 STEP 7-Micro/WIN - c:\microwin\projectl.prj
Project Edit CPU Debug Tools Setup Window Help

Ladder

CXENCERS  pata Block

Symbol Table =
Contacts 8N STL Editor - untitled.obl
Status Chart =

K Cross Reference NETWORK 1 /IStart/stop switch
Network 1 LD “Startl”

Element Usage

“Startl” . . AN “E-Stopl”
I O Symbolic Addressing Ctr| = Q0.0
O Toolbar NETWORK 2 //End
MEND

[ Status Bar
Instruction Toolbar

Zoom...

Figure 3-24  Changing the Program View from Ladder to Statement List
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3.7 Creating a Data Block

You can use the Data Block Editor to pre-define or initialize variables to be used in your

program. Usage of the data block is optional.

The Data Block Editor appears by default as a minimized window icon at the bottom of the
main window (if selected in Setup » Preferences... ). To access the data block, double-click
the icon, or click the Restore or Maximize button on the icon (in Windows 95).

Entering Data Block Values

The Data Block Editor is a free-form text editor that allows a certain degree of flexibility in the

format that you choose to enter the data values

Use the following guidelines when creating a data block:

L]
value to be stored in V. memory.

® Separate the starting address from the data

Use the first column of each line to specify the data size and starting address of each

value(s) by a space or tab as shown below.

Figure 3-25 shows a sample data block with comments that describe each data element.

EN Data Block Editor - untitled.dbl

VBO 255 /Istored as a byte, starting at VBO
VW2 256 /lword value, starting at VW2
vD4  700.50 /ldouble word real number, starting at VD4
VB8 -35 /Ibyte value, stored starting at VB8
VW10 16#0A /lword value in HEX, stored starting at VW10
VD14 123456 /ldouble word value, stored starting at VD14
VW20 24816 /ltable of word values, starting at VW20

-2 64 12 56 /l(note that data values in 2nd and

8510 20 40 //3rd line cannot start in column 1)
VB45 ‘'Up’ /ltwo-byte ASCII string, starting at VB45
V50  'This is a new message with 40 characters’

/IASCII string starting at VB50 (through VB89)

}/WQO 65535 //Word value starting at VW90

Acgﬂjr r?]sns Data values Comments

Figure 3-25  Example of a Data Block
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Warning

STEP 7-Micro/WIN uses column 1 of every line in the Data Block Editor to determine the
starting address for the values to be stored in the data block. If you enter a number in
column 1, that number is interpreted as the starting address in V. memory for any data that
follow. If you intended the number in column 1 to be a data value and not an address, this
could inadvertently cause data entered in the data block to be overwritten by the new data.

Referencing incorrect data could lead to unpredictable activity within the process when you
download the data block to a CPU. Unpredictable operations could cause death or serious
personal injury and/or damage to equipment.

To help ensure that data are stored in the correct locations in V memory, always specify a
size and address, such as VB100. Also, always proofread carefully to ensure that no data
value was inadvertently entered in column 1.

Table 3-4 gives examples of the notation to be used when entering values for a data block.

Table 3-4 Notation for Entering Values in a Data Block

Data Type Example
Hexadecimal 16#AB
Integer (decimal) 10 or 20
Signed integer (decimal) -10 or +50
Real (floating point): use a period (“.”) and not a comma (*,”) 10.57
Text (ASCII): string text, contained within apostrophes 'Siemens’
(Note: “$" is a special character for designating that the following charactef iSlaat$’s it’
apostrophe or a dollar sign within a string.) 'Only $$25’

Table 3-5 shows the valid designators for entering the data size and starting address.

Table 3-5 Valid Size Designators

Size of Data Example Description

Byte VB10 Stores the values that follow as bytes of data, starting at the
address specified.

Word VW22 Stores the values that follow as words of data, starting at the
address specified.

Double Word | VD100 Stores the values that follow as double words of data, stafting
at the address specified.

Auto-size V10 Stores the data in the minimum size (byte, word, or double
word) required for storing the values. The values entered [on
that line are stored starting at the specified V address.

Keep the (Address column| Stores data in byte, word, or double word, depending on the

previous size | is empty) size specified in the preceding line.

S7-200 Programmable Controller System Manual
C79000-G7076-C230-02

3-33



Installing and Using the STEP 7-Micro/WIN Software

3.8

Using the Status Chart

You can use the Status Chart to read, write, or force variables in your program.

The Status Chart editor appears by default as a minimized window icon at the bottom of the
main window (if selected in Setup » Preferences... ). To access the Status Chart,
double-click the icon, or click the Restore or Maximize button on the icon (in Windows 95).

Reading and Writing Variables with the Status Chart

Figure 3-26 shows an example of a Status Chart. To read or write variables using the Status
Chart, follow these steps:

1.

In the first cell in the Address column, enter the address or the symbol name of an
element from your program that you want to read or write, and press ENTER. Repeat this
step for all of the additional elements that you want in the chart.

If the element is a bit (I, Q, or M, for example), the format is set as bit in the Format
column. If the element is a byte, word, or double word, select the cell in the Format
column and double-click or press the SPACEBAR to cycle through the valid formats.

To view the current PLC value of the elements in your chart, click the Single Read
button @ or the Continuous Read button @ on the Status Chart.

To stop the updating of status, click the Continuous Read button.

To change a value, enter the new value in the “Change Value” column and click the
Write button to write the value to the CPU.

|i_"“|‘ Status Chart

sl ol alal Xl N |
Address Format Current Value Change Value
“Start_1" Bit 2#0 1
10.2 Bit 2#0
“Ready_Light_1" Bit 240 Press the SPACEBAR or
012 — Bit 241 double-click in the cell to
VEBO Signed +84 select valid format.
VW2 Unsigned 4400 To change a value,
VW4 Bit 2#0000001000110010 enter the new value
VW6 Hexadecimal /| 16#0064 16#65 | here and click the
VD10 [Floating Point | 0.0000 10.0 | Write button.
VD14 ASCII ‘TEMP’ /
VW20 Hexadecimal 16#0027 16#28
VW24 ASCII ‘AB’ ‘BA

Figure 3-26  Example of a Status Chart
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Forcing Variables Using the Status Chart

To force a variable in the Status Chart to a specific value, follow these steps:

1.

For a cell in the Address column, enter the address or symbol name of the variable that
you want to force.

If the element is a bit (10.0, QO0.1), the format is always bit and cannot be changed. If the
element is a byte, word, or double word, select the format that you wish to use by
double-clicking or pressing the SPACEBAR to cycle through the valid formats.

To force the variable to its current value, first read the current values in the PLC by
selecting the menu command Debug > Single Read or clicking the Single Read

button .

Click or scroll to the cell that contains the current value you wish to force. Press the Force
button while positioned on a current value to force the variable to that value.

To force a new value for a variable, enter the desired value in the “Change Value”
column and press the Force button.

To view all currently forced variables, click the Read Force button.

To unforce all currently forced variables in the CPU, click the Unforce All button.

Editing Addresses

To edit an address cell, use the arrow keys or mouse to select the cell you want to edit.

If you begin typing, the field clears and the new characters are entered.

If you double-click the mouse or press F2, the field becomes highlighted and you can use
the arrow keys to move the editing cursor to the place that you want to edit.
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3.9

Using Symbolic Addressing

The Symbol Table allows you to give symbolic names to inputs, outputs, and internal
memory locations. See Figure 3-27. You can use the symbols that you have assigned to
these addresses in the Ladder Editor, STL Editor, and Status Chart of STEP 7-Micro/WIN.
The Data Block Editor does not support the use of symbolic names.

Guidelines for Entering Symbolic Addresses

The first column of the Symbol Table is used to select a row. The other columns are for the
symbol name, address, and comment. For each row, you assign a symbolic name to the
absolute address of a discrete input, output, memory location, special memory bit, or other
element. A comment for each assigned symbol is optional. Follow these guidelines when

creating a Symbol Table:

You can enter symbol names and absolute addresses in any order.

You can use up to 23 characters in the Symbol Name field.

You can define up to 1,000 symbols.

The Symbol Table is case-sensitive: for example, “Pumpl” is considered a different

symbol from “pumpl”.

All leading and trailing spaces are removed from the symbol nhame by the Symbol Table
Editor. All adjacent internal spaces are converted to a single underscore. For example,
“Motor starter 2" changes to “Motor_starter_2".

If you have duplicate symbol names and/or addresses, they are marked with blue italics
by the Symbol Table Editor These duplicate names are not compiled, and they are not
recognized outside the symbol table. Overlapping addresses are not flagged as
duplicates; for example, VB0 and VWO overlap in memory but are not flagged as

duplicates.

Starting the Symbol Table Editor

3-36

The Symbol Table Editor appears by default as a minimized window icon at the bottom of the
main window. To access the Symbol Table, double-click the icon, or click the Restore or
Maximize button on the icon (in Windows 95).

=y Symbol Table - untitied.sym =[] x|
_, Symbol Name | Address | Comment |
_ | starta 10.0 | To clear a cell, press the poly line 1

|| Ee-stop1 10.1 | DELETE key or SPACEBAR  ksembly line 1

J ReadyLight1 Q1.0 when cell is selected. light (green)

|| motorstarter1 Q1.1 ASSEMDIy Line 1 motor

J Mixerl_Timer TO ] X

J Mixer2_Timer T37 :

J Linel_Counter C1 grlépgﬁsa;g ;é/;nil;ols

__l|relay 1 «—TM0.0| italics.

| | relay 1 MO.1 ‘

Figure 3-27

Example of a Symbol Table
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Editing Functions within the Symbol Table

The Symbol Table provides the following editing functions:

Edit » Cut/ Copy / Paste within a cell or from one cell to another.
Edit » Cut/ Copy / Paste one or several adjacent rows.

Edit » Insert Row above the row containing the cursor. You can also use the INSERT or
INS key for this function.

Edit » Delete Row for one or several highlighted adjacent rows. You can also use the
DELETE or DEL key for this function.

To edit any cell containing data, use the arrow keys or mouse to select the cell that yo